Microsoft PowerPoint 2007: Module 1

August, 2007
Table of Contents

Objectives ................................................................. 1
Microsoft Office PowerPoint 2007 ................................. 3
The New PowerPoint Environment .................................... 4
Microsoft Office Button .................................................. 5
    Open, Save, Print, Publish and Close a presentation ........... 5
Quick Access Toolbar (QAT) .............................................. 6
    Activity 1 ............................................................... 6
Ribbon ............................................................................. 7
Contextual Tools .............................................................. 8
Home Tab .......................................................................... 9
    Clipboard ....................................................................... 9
    Slides ........................................................................... 9
    Font ............................................................................ 9
    Paragraph ................................................................. 9
    Drawing ....................................................................... 9
    Editing ....................................................................... 9
    Activity 2 ..................................................................... 9
Insert Tab .......................................................................... 10
    Tables .......................................................................... 10
    Illustrations .............................................................. 10
    Links ........................................................................... 10
    Text ........................................................................... 10
    Media Clips .................................................................. 10
Design Tab .......................................................................... 11
    Page Setup .................................................................... 11
    Themes ....................................................................... 11
    Background ................................................................... 11
    Activity 3 ..................................................................... 12
Animations Tab ................................................................. 13
Slide Show Tab ................................................................. 13
Review Tab ......................................................................... 14
View Tab ........................................................................... 14
Add-Ins Tab ....................................................................... 15
Presentation Shortcut Keystrokes ........................................ 16
Final Activity ...................................................................... 17
Objectives

Upon completion of this module, participants will be able to:

1. Start and Quit Microsoft Office PowerPoint 2007;
2. Describe the new PowerPoint 2007 Environment;
3. Locate and use the Microsoft Office Button;
4. Locate and Customize the Quick Access Toolbar (QAT);
5. Locate and use Tabs, Groups, and Commands in the Ribbon U.I.;
6. Experiment with Live Preview;
7. Browse and Select a Design theme;
8. Create a Title Slide and Content Slide;
9. Duplicate a slide
10. Format text (style, size, color, effects, alignment);
11. Save and Close a presentation;
12. Change Document Properties;
13. Open an existing presentation;
14. Change the layout of a slide;
15. Rearrange slides in a presentation;
16. Display different views of a presentation;
17. Publish a presentation as a handout in Microsoft Word format;
18. Preview, Print and Close a presentation.
Microsoft PowerPoint 2007

PowerPoint 2007 is the easiest way to efficiently create effective presentations. This new version has many new features to increase your productivity. As with all programs in the 2007 Microsoft Office release, the most common way to start PowerPoint is from the Start menu on an XP operating system.

Opening PowerPoint

1. Click on Start > All Programs > Microsoft Office > Microsoft Office PowerPoint 2007.
The New PowerPoint Environment

The New PowerPoint environment is designed to more closely reflect the way people work with the program, making common features more accessible. The look of the program window has drastically changed. On the top portion of the window a wide band with groups of commands, known as the **Ribbon** has replaced the earlier design of menus and toolbars.

### Office 2007 Common New Features

1. New User Interface  
2. The Microsoft Office Button  
3. The Quick Access Toolbar  
4. The Mini Toolbar  
5. The Ribbon  
6. Quick Style Galleries  
7. Live Preview  
8. XML File Format – Word, Excel, and PowerPoint

### Office 2007 PowerPoint New Features

1. SmartArt-dynamic 3D text boxes  
2. Enhanced Tables and Charts  
3. New default theme Layouts  
4. Over a dozen different effects  
5. Six new optimized fonts  
6. New text and text box effects  
7. Shared controls - easier to import Word and Excel tables  
8. Optional: Sharing Slides with the Library-SharePoint Server
Microsoft Office Button

The Microsoft Office Button is located in the upper-left corner of the window. PowerPoint displays the Office Button menu that provides you with access to a list of common commands. This menu takes the place of the File menu that appeared in previous versions of PowerPoint.

Office Button Menu

1. On the left of the menu there are commands for tasks associated with the presentation as a whole.

2. At the bottom of the menu you have buttons that allow you to change the program options and quit PowerPoint.

Press the Esc key or click outside the window to close the menu.

When providing students with an online handout of a PowerPoint presentation it is best to Publish the presentation to Microsoft Word, a more commonly available application.
Quick Access Toolbar

The Quick Access Toolbar (QAT), located to the right of the Microsoft Office Button, can be customized to include buttons representing common commands, frequently used. By default, the QAT displays the Save, Undo, and Redo commands.

Customizing the QAT

1. Click the Customize Quick Access Toolbar button to customize the QAT.
2. Select or de-select the command of your choice to include or remove.

Activity 1

Use the Office Button to Open the document titled PPT_Activity1_mod1. (NOTE: The document is located on the desktop, in the PowerPoint folder.)

1. Save As “your last name_PowerPoint I”
2. Customize your Quick Access Toolbar by adding the “Open” command.
3. When finished, minimize the document.
**Ribbon**

The **Ribbon** User Interface, located below the Title Bar, **Groups** similar **Commands** on a set of **Tabs** that make up the Ribbon.

1. **Tabs** are designed to be task oriented.
2. **Groups** within each task break a task into subtasks.
3. **Commands** in each group carry out a task or display a menu of commands.

There are **eight** standard Tabs on the Ribbon whenever you start PowerPoint 2007.

1. **Home** tab - groups items related to creating slide content.
2. **Insert** tab - organizes all items that you can insert.
3. **Design** tab - organizes items related to the appearance of your presentation.
4. **Animations** tab - organizes items related to slide animation.
5. **Slide Show** tab - organizes items related to displaying your presentation.
6. **Review** tab - groups items related to comments, changes and editorial tools.
7. **View** tab - groups items related to changing the view or display of the presentation.
8. **Add-Ins** tab - groups programs added-in (downloaded) to extend the functionality of PowerPoint 2007.
Contextual Tools

Other than the standard Tabs, **Contextual Tools** are **Tabs** that appear in the Ribbon only when they are needed.

1. **Contextual tools** enable you to work with an object that you select on the page, such as a table, picture, or drawing.

2. When you click and select an object the pertinent set of **Contextual Tabs** appear in an accent color next to the standard tabs.
Home Tab

MS Office 2007 defaults to the Home tab, also known as the Primary tab. It contains the more frequently used commands, organized into six task Groups:

1. **Clipboard** group contains cut, copy, paste, and format painter commands.

2. **Slides** group contains commands to add a slide, change a slide-layout, reset a slide and delete a slide.

3. **Font** group contains the font editing features including type, size, color, style, and effects.

4. **Paragraph** group contains formatting features including justification, spacing, bulleted, numbering, indent, borders, and fill.

5. **Drawing** group contains commands to work with shapes

6. **Editing** group contains the Find and Replace commands.

Activity 2

Maximize the PowerPoint document you just saved. Perform the following tasks:

1. Add a new slide;
2. Copy the Subtitle Text on slide one to the Title Text Box on the new slide;
3. Increase the title text, font size to 48 pt. on the new slide;
4. Select the object on slide 2; reduce brightness to “-10%” and add a border;
5. Find the word “material” and replace with “content”.
6. Save your changes.
7. Minimize presentation.
Insert Tab

This tab groups all tasks related to items you may want to put on a slide, organized in five **Groups**:

1. **Tables** insertion tool makes it simple to highlight the number of columns and rows that you want your table to contain, and to add an Excel Spreadsheet that can easily be formatted.

2. **Illustrations** group contains commands to insert Pictures, Clipart (drawings, movies, sound and photography), “ready-made” Shapes, SmartArt Graphics, and Charts.

3. **Links** allows you to insert action links that can be set up to open another presentation, files, programs, URLs, or to reference another slide within the current presentation.

4. **Text** group contains commands for inserting Text Box, Header/Footer, WordArt, Date and Time, Special Characters, and Linkable Objects.

5. **Media Clips** group contains commands that allow you to insert Movies and Sound from a file or clip organizer; play CD audio track and record sound.

**Note:** Only the **Text Group** will be covered in this module. The other four groups (**Tables, Illustrations, Links, and Media Clips**) within the **Insert Tab** are included in the Advanced PowerPoint workshop, module two.
Design Tab

This tab groups tasks related to the appearance of your presentation and are organized on the Design tab, in three Groups:

1. **Page Setup** group contains a command to launch the Page Setup Dialogue Box and a command to select the Orientation of your presentation.

2. **Themes** group contains commands that enable you to change the design of your presentation with just one click. A Gallery (with Live Preview) of formatting styles provides choices that ensure a consistent and professional presentation.

3. **Background** group contains commands that allow you to select Background Styles, launch the Background Dialog Box, and hide background graphics.

*Live Preview* is a new feature in MS Office 2007 that allows you to point to a gallery choice and see its effect on the document without actually selecting the choice.
Activity 3

Maximize your presentation, if minimized. Perform the following tasks:

1. **Insert** a Text Box on Slide six;
   Note: the **Contextual Tab, “Drawing Tools”** appears-

2. **Type “MS PowerPoint 2007 New Interface”** in text new box;

3. **Select Format Tab**;

4. **Choose** a shape style for the text box, a shape fill, a shape outline, and an effect;

5. **Change** the Design Theme of your presentation;

6. **Preview** and **Save**;

7. **Publish** your presentation to MS Word to create a handout;

8. **Save** Word handout to the PPT folder on the desktop, as “your last name_PPT Handout”;

9. **Print** the MS Word handout of your PowerPoint presentation;

10. **Close** Word document and PowerPoint presentation.

The additional content presented in this module will be covered in greater detail in **Advanced PowerPoint, Module 2**. The following MS Office 2007, PowerPoint Tabs (Animations, Slide Show, Review, View and Add-Ins) will only be briefly described in this module.
Animations Tab

This tab groups commands related to creating and modifying animation effects for your presentation and are organized on this tab in three Groups:

1. Preview
2. Animations
3. Transition To This Slide

Slide Show Tab

This tab groups commands related to setting up and starting slide shows in presentation mode, and are organized in three Groups:

1. Start Slide Show
2. Set Up
3. Monitors
**Review Tab**

This tab groups commands related to comments, changes, and editorial tools, organized in three **Groups:**

1. Proofing
2. Comments
3. Protect

**View Tab**

This tab groups commands related to changing the view or the display of the presentation, and consists of six **Groups:**

1. Presentation Views
2. Show/Hide
3. Zoom
4. Color/Grayscale
5. Window
6. Macros lists
Add-Ins Tab

An **Add-In** extends functionality, such as smart tags, to Microsoft Office programs. An **Add-In** can add buttons and custom commands to the Ribbon. You can get Add-Ins for PowerPoint on the Microsoft Office Online Web site in the Downloads area, or on third party vendor Web sites.

When you download and install an **Add-In**, it appears on the **Add-Ins Tab** of an Office program according to its functionality and includes a Special Screen Tip that identifies the developer.

You can view and manage **Add-Ins** from the Add-In area in PowerPoint Options.
**Presentation Keyboard shortcuts for PowerPoint 2007**

You can use the following keyboard shortcuts while you run your presentation in full screen mode.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start a presentation from the beginning.</td>
<td>F5</td>
</tr>
<tr>
<td>Perform the next animation or advance to the next slide.</td>
<td>N, ENTER, PAGE DOWN, RIGHT ARROW, DOWN ARROW, or SPACEBAR</td>
</tr>
<tr>
<td>Perform the previous animation or return to the previous slide.</td>
<td>P, PAGE UP, LEFT ARROW, UP ARROW, or BACKSPACE</td>
</tr>
<tr>
<td>Go to slide number.</td>
<td>number+ENTER</td>
</tr>
<tr>
<td>Display a blank black slide, or return to the presentation from a blank black slide.</td>
<td>B or PERIOD</td>
</tr>
<tr>
<td>Display a blank white slide, or return to the presentation from a blank white slide.</td>
<td>W or COMMA</td>
</tr>
<tr>
<td>Stop or restart an automatic presentation.</td>
<td>S</td>
</tr>
<tr>
<td>End a presentation.</td>
<td>ESC or HYPHEN</td>
</tr>
<tr>
<td>Erase on-screen annotations.</td>
<td>E</td>
</tr>
<tr>
<td>Go to the next slide, if the next slide is hidden.</td>
<td>H</td>
</tr>
<tr>
<td>Set new timings while rehearsing.</td>
<td>T</td>
</tr>
<tr>
<td>Use original timings while rehearsing.</td>
<td>O</td>
</tr>
<tr>
<td>Use mouse-click to advance while rehearsing.</td>
<td>M</td>
</tr>
<tr>
<td>Return to the first slide.</td>
<td>1+ENTER</td>
</tr>
<tr>
<td>Redisplay hidden pointer and/or change the pointer to a pen.</td>
<td>CTRL+P</td>
</tr>
<tr>
<td>Redisplay hidden pointer and/or change the pointer to an arrow.</td>
<td>CTRL+A</td>
</tr>
<tr>
<td>Hide the pointer and navigation button immediately.</td>
<td>CTRL+H</td>
</tr>
<tr>
<td>Hide the pointer and navigation button in 15 seconds.</td>
<td>CTRL+U</td>
</tr>
<tr>
<td>Display the shortcut menu.</td>
<td>SHIFT+F10</td>
</tr>
<tr>
<td>Go to the first or next hyperlink on a slide.</td>
<td>TAB</td>
</tr>
<tr>
<td>Go to the last or previous hyperlink on a slide.</td>
<td>SHIFT+TAB</td>
</tr>
<tr>
<td>Perform the &quot;mouse click&quot; behavior of the selected hyperlink.</td>
<td>ENTER while a hyperlink is selected</td>
</tr>
</tbody>
</table>
Final Activity: Module 1

Create a presentation using the guidelines, concepts, and skills presented in this module. This will be a skill building assignment, increasing in difficulty, to be completed in the Advanced PowerPoint 2007 workshop. **All completed tasks should be saved as indicated below** to ensure that your work is available at the Advanced Level workshop.

**Guidelines:**

You may **create a presentation with content of your choice or by using the content provided** by your instructor, as described below:

Topic: Health and Wellness--According to the National Heart, Lung and Blood Institute, nearly one-third of American adults are inflicted by the “silent killer,” high blood pressure. This disease affects people of all ages and ethnicities. Use the concepts and techniques presented in this module to create a presentation following the outline provided by your instructor, in the file named: `PPT_FinalActivity_mod1_data1`.

**Perform the following tasks:**

1. **Create** a Title Slide and minimum of three Content Slides.
2. **Type** your original content or copy and paste your content from the outline.
3. **Add** a Text Box, to the bottom, right hand corner of the title slide with your name.
4. **Apply** the “CIVIC” Design Theme.
5. **Change** the Background Style to Style 11 (row 3, column 3).
6. **Edit** your name to bold, italicize, and the color red; adjust your text box if needed.
7. **Increase** the title text to 72 pt. and change to Baskerville Old Face.
8. **Change** the slide layout to “Two Content,” on slide 3.
9. **Apply** a “Light 1 Outline, – Accent 1” Shape Style to the title text of the content slides.
10. **Save** the presentation using the file name, “*your last name* _PPT_Final Activity*”. 